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0、概述 

    KC901 采用文本命令方式进行数据通信，即俗称的 ASCII 命令。数据

通过 USB 端口或网口进行物理连接，在 KC901 内部被转换为串行数据，供

CPU 识别。用户可以用命令行方式直接操作 KC901，也可以另外编写应用

软件，使之采用本手册规定的指令与仪器通信。 

    目前 KC901 的操作指令是未分级的描述语言，简单易懂，不需学习协

议逻辑知识即可迅速掌握。 

在本手册中，“上位机”是指用于操控 KC901 的 PC 机或其它控制装

置。“下位机”是指 KC901。 

1、指令格式及说明 

    上位机发送及下位机返回都以包作为基本数据，包头以符号“$”代表， 

包尾以换行符号“\n”代表，包内容中各个元素使用英文逗号“,”分隔。

说明如下： 

1.1 发送指令格式 

$[命令],[选项],[参数 1],[参数 n]\n 

1.2 返回数据格式 

    返回数据为便于上位机识别，其格式与发送格式略有不同，为了便于

说明，分号“;”及其同一行后的内容代表注释： 

$start,[包名称]\n  ;每行以“$”开头“\n”结尾。“start”代表起始 

$[包内容]\n        ;包内容元素之间以逗号“,”分隔 

$end\n             ;“end”代表包结束 
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1.3 格式说明 

1、不是每个命令都必须包括选项和参数，请按照指令表的规定使用。 

2、双括号[]仅仅是本手册为了方便表达而添加，实际不用输入。 

3、除专门说明外，字母大小写的意义相同。 

    4、如果输入的指令内容有错误，KC901 会在发现错误之后，立刻返回

错误提示，并且丢弃此错误包。 

5、如果输入的指令格式有错误，KC901 会丢弃掉所有错误格式，仅提

取其中的正确格式。 

1.4 通信例程 

    如果需要获取系统时间，应发送如下命令： 

    $[命令],[选项]\n 

    $date,get\n 

下面展示整个过程，紫色代表上位机发送，蓝色代表下位机返回。 

$date,get\n 

 

$start,date\n 

$2015,4,22,10,36,39\n ;依次代表年月日时分秒 

$end\n 

1.5、通信参数 

    波特率：921600 

    数据位：8 位 

    停止位：1 位 

    无校验。 
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    指令缓存：32kb。进入缓存的指令顺序执行，存满时不再接收新的指

令。编程时应考虑到执行的速度，避免拥堵。 

    数据缓存：32kb。进入缓存的数据顺序发出，缓存满时中止执行。 

    通过远程操作获取的测量数据未严格修约，需要自行取舍有效位数。 

2、上位机如何与 KC901 连接 

2.1 安装 USB 驱动 

    如果采用 USB 口连接，应安装 USB 驱动。WINDOWS 操作系统通常自带驱

动程序，只需将 KC901 的 USB 接口与 PC机连接，系统即可自动安装驱动。

如果系统未能正确安装，可以手动下载驱动程序进行安装。 

    下载链接：http://www.ftdichip.com/Drivers/VCP.htm 

如果采用网口连接，不需要安装专门的驱动。 

2.2 使用合适的调试软件 

为了简化上位机编程，我们取消了命令回显，且返回字符仅仅是换行

符“\n”。所以调试软件若不做设定则会影响显示效果。 

建议使用 SecureCRT 调试工具，可以很好的解决上述问题。具体如下

设定: 

通过勾选[View]->[Command(Chat)Window]选项，会在下方打开命令行

输入窗口，输入命令后按“回车键”即可发送。并且可以通过“上下方向

键”来追溯输入过的命令。 
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通过勾选[Options] -> [Session Options] -> [Terminal] -> 

[Emulation] -> [Modes]选项下的[New Line Mode]即可将回车符“\n”显

示为回车加换行的效果。 
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2.3 关于网络连接的操作 

2.3.1、打开网络功能 

    在进行网络连接前，应将“系统设置”（Settings，按 FUNC 键进入）

界面下的“网络”（Network）子菜单调整为“开”（ON）状态。网络功能

开启后，网络接口上的黄灯点亮。由于网络连接会消耗较多电力，在不使

用网络时，应当将网络功能关闭。 

2.3.2、配置网络参数 

    进入“系统设置”界面下的“IP 设置”（“IP SET”）子菜单，设置

KC901 的 IP 参数。设置好以后保存，若成功接入网络，则网口的绿灯会闪

烁。 

 

    端口：上位机软件设置的端口号需要与此参数一致，注意避免与其它

程序的端口相冲突。对于安装有防火墙的上位机，请在防火墙中放行对应

的端口。 

    IPv4 地址：请在所接入网络允许的范围内选择，并且该地址不能与网
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络中的其它设备冲突。 

    IPv4 网关：请根据路由器的参数设置。通常的局域网，网关默认为

192.168.1.1。 

    IPv4 子网掩码：请根据接入网络的具体情况设置，通常为

255.255.255.0。 

通常网络中最好有路由器。不论 KC901 还是上位机，都作为该网络的

一个终端。如果希望直接将 KC901 连接到电脑上，相当于电脑直接连电脑，

对于某些早期的网卡，如果连接不上，可以试试反序的网线。 

2.4 与 KC901 握手 

注意：请确保当前 KC901 没有窗口显示（比如“关于本机”），若在

KC901 显示窗口下进行握手，KC901 会返回警告字符串： 

$start,ConFail\n 

$Please exit the window operation first.\n 

$end\n 

    此时请先退出窗口显示，再进行握手操作。 

申请控制 

发送大写的 C 

等待大约 1秒时间，返回[KC901]及其序列号。此时 KC901 进入远动模

式。 

2.5 与 KC901 断开 

断开方式有两种： 

    1、上位机发送命令断开，详见：3.2.16 退出远程控制模式。 

    2、在 901 上按下[SHIFT]+[MODE]按键主动断开。 
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    如果在通信中意外拔出 USB 插头或者因其它原因中断通信，901 不会自

动识别，仍需通过[SHIFT]+[MODE]按键来终止。 

2.6 终止数据返回 

在 901 有连续的数据返回时，如果需要终止目前操作，需要在上位机

采用组合键[Ctrl]+[C](也就是 16 进制的 0x03)，此时 901 会终止执行已经

收到的命令，并将已经测到，但尚未发送完毕的数据全部发完，然后停止

返回数据。 

注意： 

1、当终止数据返回后，KC901 会完全归回初始状态。例如，使用 s11 RUN

指令采集数据的过程中按下了组合键[Ctrl]+[C]，则需要再次发送s11 init

后，才能继续运行 s11 run。 

2、若使用 SecureCRT 调试 KC901，需要用鼠标点击数据显示窗口，然

后就可以直接[Ctrl]+[C]。 

3.指令说明 

下面将对 KC901 的所有指令进行详细说明，并给出实际运行例程。对

于例程的格式，需要注意的是： 

1、紫色代表上位机发送，蓝色代表下位机返回。 

2、发送和返回都会明确标明回车符“\n”，实际返回看不见的。 

3、注意指令与选项及参数之间都需要逗号做分隔。 

4、使用分号“;”及同行后的内容为注释，并不属于实际格式。 

3.1 指令的分类 

指令可以归类为以下 3类： 
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1.系统设置指令 

    属于下行指令，例如设置液晶亮度、发射机输出衰减。 

2.测量控制指令 

    属于下行指令，例如使用 S11 模式测量对应频率点的 S参数。 

3.警告 

    属于上行指令，例如过载警告、高温警告。 

3.2 系统指令 

3.2.1 系统时间 

命令 选项 说明 

date 

get 获取时间 

set 

设置时间，格式如下： 

年 月 日 时 分 秒 

XXXX-XX-XX, XX-XX-XX 

例程: 

  获取 KC901 系统时间： 

$date,get\n 

 

$start,date\n 

$2015,4,22,12,22,8\n ;依次为年月日时分秒 

$end\n 

  设置时间: 

    $date,set,2016-4-22,13-51-00\n 

注意：输入年份应当在 2000-2099 之间。 
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3.2.2 设置 901 液晶显示语言 

命令 选项 说明 

lang 
en 

目前支持简体中文和英语两种语言 
ch 

例程： 

  设置显示语言为英语 

$lang,en\n 

3.2.3 设置旋钮方向 

命令 选项 说明 

encoder 
right 逆时针拨动，数量增大 

顺时针拨动，数量增大 left 

例程： 

  设置旋钮为逆时针拨动时，频率数据增加： 

$encoder,right\n 

3.2.4 设置输出衰减 

命令 选项 说明 

outAtt 无 

参数取值范围与版本相关： 

KC901V/RFMA  : 0~25 

KC901S+ :0~20 

单位：dB 

此输出衰减在以下模式中生效： 

S11（反射）， 

DTF（故障定位）, 
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S21,（传输） 

Insertion（插入损耗）, 

例程： 

  输出衰减器置 10dB 衰减 

$outAtt,10\n  

 

3.2.5 设置亮度 

命令 选项 说明 

light 
lcd lcd 取值范围 1-100 

key 取值范围 0-100 key 

例程： 

  设置显示器亮度为 100% 

$light,lcd,100\n 

 

3.2.6 气压计 

命令 选项 参数 说明 

press 
set   数值 

设置绝对高度补偿，单位是 m，范围：

-999.9-999.9 

注意：当设置完高度补偿后，读取的海拔数

据会缓慢变化到补偿后的值（因为数据存在

滑动滤波以保证稳定性） 

get 无 读取气压数据，依次返回 hPa 和 m 单位 

例程： 

  高度补偿正 100 米 
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    $press,set,100.0\n 

  读取气压测试数据，要求返回以百帕为单位的值 

$press,get\n 

$start,press\n 

$950.412,536.802\n  ;依次为气压(hPa)和海拔(m) 

$end\n 

 

3.2.7 按键提示音 

命令 选项 说明 

beep 
off off->关闭 

on->打开 on 

例程： 

  打开按键提示音 

    $beep,on\n 

 

3.2.8 S11 电缆补偿 

命令 选项 说明 

cable 

len 电缆长度，单位为米，范围 0-99.999 

loss 电缆衰减，单位为 dB，范围 0-99.99 

freq 电缆衰减对应的频率，单位为 MHz，范围 1-10000 

例程： 

  设置电缆长度补偿值为 10.123 米 

$cable,len,10.123\n 
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3.2.9 S11 系统校准件参数 

KC901V/RFMA 使用如下方式的复杂校准模型： 

命令 选项 说明 

kit_s11 无 

依次输入短路、开路校准件参数。 

其中，短路件参数依次为： 

L0,L1,L2,L3,单程电长度（mm），总损耗（GΩ/m） 

开路校准件参数依次为： 

C0,C1,C2,C3,单程电长度（mm），总损耗（GΩ/m） 

取值范围： 

L0~L3，C0~C3 范围：-9999.999 - +9999.999 

单程电长度范围：0 – 999.999 

总损耗范围：0 – 9999.999 

注意：此处设置的是系统校准的校准件数据，对应

仪表界面上是在[系统设置]界面按下[SHIFT]+[7]

进入的系统校准界面下的设置(而不是在[系统设

置]本界面下的用户校准件设置) 

例程： 

 设置短路、开路及负载校准件电长度依次为：5.25mm，5.26mm 

//  L0,L1 , L2,L3,mm,GΩ/m     C0, C1, C2, C3, mm, GΩ/m 

$kit_s11,10,125,-20,15,5.25,0.201,100,125,-800,15,5.26,0.200\n 

 

KC901S+使用如下方式的简易校准模型： 
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命令 选项 说明 

kit_s11 无 

依次输入短路、开路、负载校准件电长度参数。 

输入范围：0-99.99(单位：mm) 

注意：此处设置的是系统校准的校准件数据，对应

仪表界面上是在[系统设置]界面按下[SHIFT]+[7]

进入的系统校准界面下的设置(而不是在[系统设

置]本界面下的用户校准件设置) 

例程： 

设置短路、开路及负载校准件电长度依次为：0.12mm,0.34mm,0.56mm 

$kit_s11,0.12,0.34,0.56\n 

 

3.2.10 S21 系统校准件参数 

命令 选项 说明 

kit_s21 无 

依次输入校准件长度和校准件衰减 

长度范围:0—999.999(单位：mm) 

衰减范围:0—99.9999(单位：dB) 

衰减位于的频率:1—10000（单位：MHz） 

例程： 

 设置校准件长度为 100.00mm，衰减 0.1dB，位于频率 4567MHz 

$kit_s21,100,0.1,4567\n 
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3.2.11 获取设备信息 

发送命令 选项 说明 

device 无 将会返回字符串说明 

说明： 

当接收到此测试命令后，KC901 会按照如下格式返回： 

$start,device\n 

$<----------------------KC901 network analyzer----------------->\n 

$<-User @ :仪器所有者名称>\n 

$<-SoftWare Ver:软件版本号-------------------------------------->\n 

$<-HardWare Ver:硬件版本号-------------------------------------->\n 

$<-Serial num:序列号-------------------------------------------->\n 

$<-Copyright:KeXinShe Co.,Ltd & KeChuang measurement association>\n 

$<-------------------------------------------------------------->\n 

$end\n 

例如： 

$device\n 

 

$start,device\n 

$<----------------------KC901 network analyzer----------------->\n 

$<-User @ :BBBB567895>\n 

$<-Software ver:V2.0.8------------------------------------------>\n 

$<-Hardware ver:MB-V1.2 RB-V1.1--------------------------------->\n 

$<-Serial num:002015123456-------------------------------------->\n 

$<-Copyright:KeXinShe Co.,Ltd & KeChuang measurement association>\n 

$<-------------------------------------------------------------->\n 

$end\n 
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3.2.12 获取电压 

命令 选项 数据说明 

voltage 无 依次返回外接电压和电池电压，单位为 V 

例程： 

  读取电池电压 

$voltage\n 

 

$start,voltage\n 

$10.82,8.06\n  ;依次为外接电压和电池电压 

$end\n 

 

3.2.13 获取机内温度 

发送命令 选项 数据说明 

temp 无 单位：℃ 

例程： 

  读取机内温度 

$temp\n 

 

$start,temp\n 

$44.2\n 

$end\n 
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3.2.14 获取 901 时间参数 

发送命令 选项 数据说明 

times 无 依次为开机次数，本次运行时间，总共使用时间  

例程： 

  读取时间参数 

$times\n 

$start,times\n 

$1223,2,52,51,2,2,52,51\n  ;依次为开机次数，开机时间(时，分，秒)， 

                       ;使用时间(天，时，分，秒) 

$end\n 

3.2.15 设置频谱模式下的参考电平 

命令 选项 说明 

specref 无 参数取值范围(+10) – (-50)，单位：dBm 

例程： 

  设置参考电平为-10dBm 

    $specref,-10\n 

3.2.16 退出远程控制模式 

命令 选项 说明 

local 无 断开上位机控制 

例程： 

    $local\n 

处理: 
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    当接收到命令后，KC901 会立即停止当前所有动作，并把控制权交给

KC901 本机。 

3.2.17 设置网络参数 

命令 选项 说明 

netinfo 无 查看当前网络设置 

ip 无 设备地址 

gw 无 网关地址 

msk 无 子网掩码 

port 无 端口号(小于 65535) 

例程： 

查看当前网络设置: 

$netinfo\n 

 

$start,NetInfo\n 

$192,168,1,2\n                 ;IP 地址 

$192,168,1,1\n                 ;网关地址 

$255,255,255,0\n               ;子掩网码 

$901\n                        ;端口号 

$end\n 

设置 IP 地址： 

     $ip,192.168.1.2\n 

设置网关地址： 

     $gw,192.168.1.1\n 
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设置子掩网码： 

     $msk,255.255.255.0\n 

设置端口号： 

     $port,901\n 

3.2.18 设置带宽 

命令 选项 说明 

bw 

1k 

3k 

10k 

30k 

设置采样带宽 

例程： 

设置带宽为 10kHz 

$bw,10k\n 

3.2.19 远程升级(仅用于台式仪器) 

发送命令 选项 说明 

update 无 通过 SD 卡升级代码 

说明： 

在发送此命令前，请确认 SD 卡中已经载入升级程序！发送命令后，

KC901 会自动重启进入远程升级模式。升级过程中会通过串口返回升级过

程，从中可以看出升级成功还是失败。 

注意: 

1、 当在远程升级过程中，若出现意外导致设备死机等其他情况。重
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启仪器便可自动重新升级。 

例程： 

     $update\n 

    2、升级过程中，串口的波特率为固定的 9216000! 

3.2.20 恢复出厂设置 

发送命令 选项 说明 

reset 无 恢复所有设置并替换系统校准为出厂校准 

例程： 

$reset\n 

 

$start,reset\n  ;对于上位机编程来说，仅需要识别包头[reset]即可，不需

要对内容进行字符串匹配 

$Restore the factory settings,confirm?[Yes/no]\n ;等待用户确认 

$end\n 

  

 $yes\n 或 $no\n 

注意: 

恢复到出厂设置后，网络配置参数也会是出厂设置，可能需要重新配置！ 

3.2.21 S11 系统校准 

发送命令 选项 说明 

cal_s11 无 S11 系统校准 

说明： 
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发送此命令后，KC901 会通过串口或网口与用户交互实现 SOL 校准。

以后的应用中都会默认调用此次校准数据。用户可以通过[Reset]命令，恢复

默认调用出厂校准。此过程会有好几次交互，对于上位机编程而言也仅需

要识别包头名即可，无需做内容字符串匹配。 

 

下面为具体流程： 

$cal_s11\n 

 

$start,s11cal_confirm\n 

$******S11 calibration******\n       ;等待用户确认是否校准 

$ Do you want to calibrate the device?[Yes/no]\n 

$end\n 

 

$yes\n 

 

$start,s11cal_wait\n                 ;等待硬件预热，时间约 5 秒，期间下

位机无数据返回 

$ waiting for the circuit to be stability...\n 

$end\n 

 

$start,s11cal_step\n                 ;提示按照下面的步骤操作 

$ start calibration, please follow these steps:\n 

$end\n 
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$start,s11cal_short\n                ;连接短路校准件 

$Step 1:Please connect the short module then send 'yes'.\n 

$end\n 

 

$yes\n (注意：确认后需要等待约 16 秒进行短路校准，期间下位机无数据返

回) 

 

$start,s11cal_open\n                ;连接开路校准件 

$Step 2:Please connect the open module then send 'yes'.\n 

$end\n 

 

$yes\n(注意：确认后需要等待约 16 秒进行开路校准，期间下位机无数据返

回) 

 

$start,s11cal_load\n                ;连接负载校准件 

$Step 3:Please connect the load module then send 'yes'.\n 

$end\n 

 

$yes\n(注意：确认后需要等待约 16 秒进行负载校准，期间下位机无数据返

回) 

 

$start,s11cal_process\n             ;提示正在计算 
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$Step 4: processing (Wait please).\n 

$end\n 

 

$start,s11cal_save\n                ;正在保存 

$ saving(wait please) \n 

$end\n 

 

$start,s11cal_completed\n           ;校准完成 

$Calibration completed!\n 

$end\n 

 

在下位机等待上位机确认的过程中，用户可以输入’exit\n’，退出校准模式。

如下所示： 

$exit\n 

 

$start,s11cal_exit\n 

$Exit calibration\n 

$end\n 

3.2.22 S21 系统设置 

发送命令 选项 说明 

cal_s21 无 S21 系统校准 

说明： 
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发送此命令后，KC901 会通过串口或网口与用户交互实现短接校准。

以后的应用中都会默认调用此次校准数据。用户可以通过[Reset]命令，恢复

默认调用出厂校准。此过程会有好几次交互，对于上位机编程而言也仅需

要识别包头名即可，无需做内容字符串匹配。 

下面为具体流程： 

$cal_s21\n 

 

$start,s21cal_confirm\n 

$******S21 calibration******\n       ;等待用户确认是否校准 

$ Do you want to calibrate the device?[Yes/no]\n 

$end\n 

 

$yes\n 

 

$start,s21cal_wait\n                 ;等待硬件预热，时间约 5 秒，期间下

位机无数据返回 

$ waiting for the circuit to be stability...\n 

$end\n 

 

$start,s21cal_step\n                 ;提示按照下面的步骤操作 

$ start calibration, please follow these steps::\n 

$end\n 
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$start,s21cal_connect\n                ;短接 PORT1 和 PORT2 

$Step 1: Please connect [SOURCE] port and [RF IN] port then send 'yes'.\n 

$end\n 

 

$yes\n(注意：确认后需要等待约 16 秒进行短路校准，期间下位机无数据返

回) 

 

$start,s21cal_process\n             ;提示正在计算 

$Step 3: processing (Wait please).\n 

$end\n 

 

$start,s21cal_save\n                ;正在保存 

$ saving(wait please)\n 

$end\n 

 

$start,s21cal_completed\n           ;校准完成 

$Calibration completed!\n 

$end\n 

 

在下位机等待上位机确认的过程中，用户可以输入’exit\n’，退出校准模式。

如下所示： 

$exit\n 
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$start,s21cal_exit\n 

$Exit calibration.\n 

$end\n 

 

3.2.23 获取系统警告信息 

发送命令 选项 说明 

getstatus 无 获取系统警告信息 

说明： 

发送此命令后，如有警告信息，KC901 会通过串口或网口返回一次系

统警告信息。 

例程： 

$getstatus\n 

 

3.2.24 清除系统警告信息标志位 

发送命令 选项 说明 

clearstatus 无 清除系统警告信息标志位 

例程： 

$clearstatus\n 
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3.3 控制指令 

3.3.1 获取 S11 测量参数 

与此功能还有关联的参数还有： 

3.2.4 设置输出衰减，3.2.8 电缆补偿 

命

令 
选项 参数 1 

参数

2 
参数 3 参数 4 参数 5 参数 6 

S11 

init 

calOn 

calOff 

ri 

ma 

vswr 

z 

loss 

** 
cs 

ss 
** ** 

run 

stop 

说明： 

1、选项： 

    init->初始化 S11 功能（在使用 S11 功能前必须使用此命令） 

    run->运行 S11 进行扫频采集 

    stop->停止并关闭 S11 功能(在使用其它工作模式前必须使用此命令) 

2、参数 1： 

    calon->打开系统校准 

    caloff->关闭系统校准 

    采用远程控制时，KC901 不能使用用户校准。如果需要进行用户校准，

有关校准算法应当在上位机上实现。 

3、参数 2： 

    ri->以实部和虚部返回数据 
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ma->以反射系数和角度返回数据 

vswr->以电压驻波比返回数据 

z->以阻抗返回数据 

loss->以回波损耗（对数值）返回数据 

4、参数 3 用于设置扫描点数，目前最大支持 1000 点。如果需要扫描的点

数超过 1000 点，可以多次运用 S11 命令进行分段扫描。 

    可以只测量 1 点，此时测量连续进行，仪器持续向上位机发送一个频

率的测量结果。 

5、参数 4： 

    cc->以 cent 和 span 的方式确定扫频范围 

    ss->以 start 和 stop 的方式确定扫频范围 

    如果参数 3设置为仅扫描 1 个频率点，则参数 4 选择 cs 和 ss 都可以，

且仅需要输入参数 5 就可以了（cent \ start 均可），参数 6 会被 KC901

解析为新的命令。 

6、参数 5 和 6 用于设置中心频率及扫宽（cs）或者起始及终止频率（ss），

以 Hz 为单位。根据参数 4的设置，只需要用其中一种方式输入数据。 

根据设备的不同，频率可操作范围有所不同，如下表所示： 

中心频率范围 

KC901M(RFMA) 9500Hz-9999999500Hz(10GHz–500Hz) 

KC901V 5500Hz-6999999500Hz(7GHz–500Hz) 

KC901S+ 5500Hz-4099999500Hz(4.1GHz – 500Hz) 

扫宽范围 

KC901M 1000Hz-9999991000Hz(10GHz–9KHz) 
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KC901V 1000Hz-6999995000Hz(7GHz–5KHz) 

KC901S+ 1000Hz-4099995000Hz(4.1GHz – 5KHz) 

起始频率范围 

KC901M 9000Hz-9999999000Hz(10GHz–1KHz) 

KC901V 5000Hz-6999999000Hz(7GHz–1KHz) 

KC901S+ 5000Hz-4099999000Hz(4.1GHz-1KHz) 

终止频率范围 

KC901M 10000Hz-10000000000Hz(10GHz) 

KC901V 6000Hz-7000000000Hz(7GHz) 

KC901S+ 6000Hz-4100000000Hz(4.1GHz) 

 

7、例程： 

当扫描点数大于 1时： 

$s11,run,caloff,ri,2,cs,100000000,50000000\n 

 

$start,s11,ri\n 

$75000000,0.528e0,-0.269e0\n  ;依次为频率，实部，虚部 

$100000000,0.471e0,-0.406e0\n 

$125000000,0.370e0,-0.475e0\n 

$end\n 

 

$s11,run,caloff,ma,2,cs,100000000,50000000\n 

$start,s11,ma\n 
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$75000000,5.847e-2,-26.497\n ;依次为频率，反射系数，相位 

$100000000,6.171e-1,-40.609\n 

$125000000,5.934e-2,-51.820\n 

$end\n 

 

$s11,run,caloff,vswr,2,cs,100000000,50000000\n 

$start,s11,vswr\n        

$75000000,3.7347\n   ;依次为频率，电压驻波比 

$100000000,4.1275\n    

$125000000,3.7658\n 

$end\n 

 

$s11,run,caloff,z,2,cs,100000000,50000000\n 

$start,s11,z\n 

$75000000,137.9871,109.6309,-83.7945\n   ;依次为频率，阻抗的模，

电阻，电抗 

$100000000,113.8715,70.5131,-89.4127\n 

$125000000,91.2070,52.7077,-74.4354\n 

$end\n 

 

$s11,run,caloff,loss,2,cs,100000000,50000000\n 

$start,s11,loss\n                         

$75000000,-0.409\n       ;依次为频率，回波损耗 
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$100000000,-0.499\n 

$125000000,-0.574\n 

$end 

当扫描点数等于 1时： 

S11 属于循环采样，每次采样结果都为一个包，如下所示： 

$s11,run,caloff,ri,1,cs,100000000\n 

 

$start,s11,ri\n 

$100000000,0.456e0,-0.391e0\n 

$end\n 

 

$start,s11,ri\n 

$100000000,0.458e0,-0.392e0\n 

$end\n 

3.3.2 获取 S21 测量参数 

注意：与此功能还有关联的参数还有：3.2.4 设置输出衰减 

命

令 
选项 参数 1 参数 2 参数 3 参数 4 参数 5 参数 6 参数 7 

S21 

init 

calon 

caloff 

ri 

ma 

Loss 

delay 

lowlo 

highlo 
** 

cs 

ss 

** 

** 

** 

** 

run 

stop 
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说明： 

1、选项： 

    init->初始化 S21 功能（在使用 S21 前必须使用此命令） 

    run-> 运行 S21 功能进行扫频采集 

    stop->停止并关闭 S21 功能(在使用其他工作模式前必须使用此命令) 

2、参数 1： 

    calon->打开系统校准 

caloff->关闭系统校准 

3、参数 2： 

ri->以实部和虚部返回数据 

ma->以传输系数和角度返回数据 

loss->以插入损耗（对数值）返回数据 

    delay->以群延时返回数据 

4、参数 3： 

    lowlo->以低本振方式扫描 

    highlo->以高本振方式扫描 

5、参数 4 用于设置扫描点数，目前最大支持 1000 点。如果需要扫描更多

频点，可以分成多个指令，分段扫描。可以设置为扫描 1 点，此时仪器将

连续工作。 

6、参数 5： 

    cs->以 cent 和 span 的方式确定扫频范围 

    ss->以 start 和 stop 的方式确定扫频范围 

    如果参数 4设置为仅扫描 1 个频率点，则参数 5 选择 cs 和 ss 都可以，
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且仅需要输入参数 6 就可以了（cent \ start 均可），参数 7 会被 KC901

解析为新的命令。 

7、参数 6 和 7 用于传输具体频率，以 Hz 为单位。根据参数 5 的设置，只

需要采用其中一种格式。 

根据设备的不同，频率可操作范围有所不同，如下表所示： 

中心频率范围 

KC901M 500Hz-9999999500Hz(10GHz–500Hz) 

KC901V 500Hz-6999999500Hz(7GHz–500Hz) 

KC901S+ 500Hz-4099999500Hz(4.1GHz -500Hz) 

扫宽范围 

KC901M 1000Hz-10000000000Hz(10GHz) 

KC901V 1000Hz-7000000000Hz(7GHz) 

KC901S+ 1000Hz-4100000000Hz(4.1GHz) 

起始频率范围 

KC901M 0-9999999000Hz(10GHz–1KHz) 

KC901V 0-6999999000Hz(7GHz–1KHz) 

KC901S+ 0-4099999000Hz(4.1GHz-1KHz) 

终止频率范围 

KC901M 10000Hz-10000000000Hz(10GHz) 

KC901V 1000Hz-7000000000Hz(7GHz) 

KC901S+ 1000Hz-4100000000(4.1GHz) 

    终止频率应当大于起始频率。 

    如果参数 4 设置为仅扫描 1 个频率点，则参数 6 为该频率点的值，参
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数 7 不用输入。 

8、例程： 

当采样点数大于 1时： 

$s21,run,caloff,ri,lowlo,2,cs,100000000,50000000\n 

 

$start,s21,ri\n 

$75000000,-0.442e-1,0.000e0\n  ;依次为频率，实部，虚部 

$100000000,-0.419e-1,0.174e-2\n 

$125000000,-0.418e-1,0.219e-2\n 

$end\n 

$s21,run,caloff,ma,lowlo,2,cs,100000000,50000000\n 

$start,s21,ma\n 

$75000000,7.097e-1,180.000\n ;依次为频率，插损，相位 

$100000000,6.758e0,157.210\n 

$125000000,6.402e0,150.816\n 

$end\n 

 

$s21,run,caloff,loss,lowlo,2,cs,100000000,50000000 

$start,s21,loss 

$75000000,-116.130    ；依次为频率，回拨损耗 

$100000000,-102.054 

$125000000,-112.225 

$end 
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$s21,run,caloff,delay,lowlo,2,cs,100000000,50000000 

$start,s21,delay 

$75000000,-5.147039e-09 

$100000000,2.589045e-09 

$125000000,2.589045e-09 

$end 

 

当扫描点数等于 1时： 

S21 属于循环采样，每次采样结果都为一个包，如下所示： 

$s21,run,caloff,ma,lowlo,1,cs,100000000\n 

 

$start,s21,ma\n 

$100000000,6.744e-1,156.693\n 

$end\n 

$start,s21,ma\n 

$100000000,6.766e0,156.762\n 

$end\n 

$start,s21,ma\n 

$100000000,6.773e0,156.731\n 

$end\n 
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3.3.3 获取频谱测量参数 

注意：与此功能还有关联的参数还有：设置频谱模式的参考电平 3.2.15。 

命令 选项 参数 1 参数 2 参数 3 参数 4 参数 5 参数 6 

spec 

init 
calon 

caloff 

lowlo 

highlo 
** 

cs 

ss 
** ** run 

stop 

说明： 

1、选项： 

    init->初始化 SPEC 功能（在使用 SPEC 前必须使用此命令） 

    run->运行 SPEC 进行扫频采集 

    stop->停止并关闭 SPEC 功能(在使用其他模式前必须使用此命令) 

2、参数 1： 

    calon->打开系统校准 

    caloff->关闭系统校准 

3、参数 2： 

    lowlo->以低本振方式扫描 

    highlo->以高本振方式扫描 

4、参数 3 用于设置扫描点数，目前最大支持 1000 点。如果需要超过该点

数，可以多次使用本指令。如果只需要扫描 1个频率，可以设置为 1，与场

强功能的区别是可以指定参考电平，而场强功能不能指定参考电平。在需

要精确测量相对值时，建议指定参考电平。 

5、参数 4： 

    cs->以 Cent 和 Span 的方式确定扫频范围 
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    ss->以 Start 和 Stop 的方式确定扫频范围 

    如果参数 3设置为仅扫描 1 个频率点，则参数 4应当设置为 CS。 

5、参数 5 和 6 设置中心频率及扫宽，以 Hz 为单位 

根据设备的不同，频率可操作范围有所不同，如下表所示： 

中心频率范围 

KC901M 500Hz-9999999500Hz(10GHz–500Hz) 

KC901V 500Hz-6999999500Hz(7GHz–500Hz) 

KC901S+ 500Hz-4099999500Hz(4.1GHz-500Hz) 

扫宽范围 

KC901M 1000Hz-10000000000Hz(10GHz) 

KC901V 1000Hz-7000000000Hz(7GHz) 

KC901S+ 1000Hz-4100000000Hz(4.1GHz) 

起始频率范围 

KC901M 0-9999999000Hz(10GHz – 1KHz) 

KC901V 0-6999999000Hz(7GHz – 1KHz) 

KC901S+ 0-4099999000Hz(4.1GHz – 1KHz) 

终止频率范围 

KC901M 10000Hz-10000000000Hz(10GHz) 

KC901V 1000Hz-7000000000Hz(7GHz) 

KC901S+ 1000Hz-4100000000Hz(4.1GHz) 

    终止频率应当大于起始频率。 

    如果参数 3设置为仅扫描 1 个频率点，则参数 4 选择 cs 和 ss 都可以，

且仅需要输入参数 5 就可以了（cent \ start 均可），参数 6 会被 KC901
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解析为新的命令。 

7、例程： 

当采样点数大于 1时： 

$spec,run,caloff,lowlo,10,cs,100000000,50000000\n 

 

$start,spec\n 

$75000000,-74.166\n  ;依次为频率和幅度(dBm) 

$80000000,-74.385\n 

$85000000,-74.228\n 

$90000000,-74.249\n 

$95000000,-74.125\n 

$100000000,-74.456\n 

$105000000,-74.422\n 

$110000000,-74.147\n 

$115000000,-74.077\n 

$120000000,-74.295\n 

$125000000,-74.314\n 

$end\n 

当扫描点数等于 1时： 

SPEC 属于循环采样，每次采样结果都为一个包，如下所示： 

$spec,run,caloff,lowlo,1,cs,100000000\n 

 

$start,spec\n 
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$100000000,-74.307\n 

$end\n 

$start,spec\n 

$100000000,-74.540\n 

$end\n 

$start,spec\n 

$100000000,-74.310\n 

$end\n 

 

3.3.4 获取场强测量参数 

注意：与此功能还有关联的参数还有：3.2.4 设置输出衰减 

命令 选项 参数 1 参数 2 参数 3 

field 

init 
lowlo 

highlo 
** ** run 

stop 

说明： 

1、选项： 

    init->初始化 FIELD 功能（在使用 FIELD 前必须使用此命令） 

    run->运行 FIELD 进行扫频采集 

    stop->停止并关闭 FIELD 功能(在使用其他工作模式前必须使用此命

令) 

2、参数 1： 

    lowlo->以低本振方式测试 
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    highlo->以高本振方式测试 

3、参数 2：天线增益，以 dBi 为单位。 

     天线增益范围：-100.00…+100.00dBi 

4、参数 3：扫描单点频率以 Hz 为单位，可以精确到 0.1Hz。 

根据设备的不同，频率可操作范围有所不同，如下表所示： 

频率范围 

KC901M 0Hz-10000000000Hz(10GHz) 

KC901V 0-7000000000Hz(7GHz) 

KC901S+ 0-4100000000Hz(4.1GHz) 

5、例程： 

   场强数据是循环扫描，所以每次接受到的数据都是一个单独的包，比如： 

$field,run,lowlo,10,100000000\n 

 

$start,field\n 

$100000000.0,-18.115,-121.917\n    ；依次为频率，场强，绝对强

度(dBm) 

$end\n 

$start,field\n 

$100000000.0,-18.875,-122.337\n 

$end\n 

$start,field\n 

$100000000.0,-18.667,-122.087\n 

$end\n 
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3.3.5 控制射频信号源输出 

命令 选项 参数 1 参数 2 参数 3 参数 4 参数 5 参数 6 

rfSour

ce 

init off 

ask 

fm 

port1 

port2 

afout 

** ** ** ** run 

stop 

说明： 

1、选项： 

    init->初始化 RfSource（在使用 RfSource 前必须使用此命令） 

    run->运行 RfSource 并输出信号 

    stop->停止并关闭 RfSource 功能(在使用其他工作模式前必须使用此

命令) 

2、参数 1： 

    off->关闭调制功能，此时参数 4和参数 5不需要输入 

ask->打开 ASK 调制 

fm->使用 FM 调制 

3、参数 2： 

port1->选择输出口为端口 1输出(PORT 1) 

port2->选择输出口为端口 2输出(PORT 2) 

afout->选择输出口为音频输出（AFOUT） 

3、参数 3： 

根据设备的不同，载波频率可操作范围有所不同，如下表所示： 

载波频率范围 

KC901M 0Hz-10000000000Hz（10GHz） 
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KC901V 0-7000000000Hz(7GHz) 

KC901S+ 0-4100000000Hz(4.1GHz) 

 但切换为音频输出时，频率范围为 0-60000000Hz(60MHz) 

4、参数 4： 

   载波输出幅度 单位 dBm,精度 1dB  

   端口的输出幅度根据频率不同而不同。 

   当用户输入幅度高于实际可以输出的最大值时，下位机返回警告，并且

以最大值输出。 

$start,warn_gtr\n    ;用户输入大于最大值 

$warn:It is greater than the maximum output!\n 

$end\n 

   当用户输入幅度低于实际可以输出的最大值时，下位机返回警告，并且

以最小值输出。 

$start,warn_lt\n    ;用户输入大于最大值 

$warn:It is less than the minimum output!\n 

$end\n 

当输出端口为“port2”时，大致取值范围：+10 至-30dBm 

当输出端口为“port1”，且射频板版本不低于“1.0.5”时，取值范围：

+10 至-60dBm，否则取值范围依然为：+10 至-30dBm 

5、参数 5： 

   调制频率 单位 Hz 取值范围：0-3000Hz 

6、参数 6： 

   当为 ASK 调试时调制深度，仅有几个固定取值：0，5，10，15，20，30，
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35，40，45，50，55，60，65，70，75，80，85，90。 

   当为 FM 调制时，其可调深度随频率而变化，如下表所示 

0 – 60M(不包含 60M) 0 - 10MHz 

60M – 106.25M(不含 106.25M) 0 – 312.5KHz 

106.25M – 212.5M(不含 212.5M) 0 – 625KHz 

212.5M – 425M(不含 425M) 0 – 1.25MHz 

425M – 850M(不含 850M) 0 – 2.5MHz 

850M – 1700M(不含 1700M) 0 – 5MHz 

1700M – 3400M(不含 3400M) 0 – 10MHz 

3400M – 7000M 0 – 20MHz 

 

7、例程： 

    控制射频信号源输出，要求打开调制，载波频率 1GHz，输出不衰减，

调制频率 1KHz，调制深度 90%。 

    第一步 初始化 RfSource 功能： 

    $rfsource,init\n  

    第二步 开始运行和设置： 

$rfsource,run,ask,port1,1000000000,0,1000,90\n  

    第三步 如果需要使用其它功能，需先退出射频信号源： 

    $rfsource,stop\n 

8、处理：  

    （1）当输入选项为 Init 时，KC901 会立即初始化与射频信号源相关的

电路。 
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    （2）当输入选项为 STOP 时，KC901 会关闭与射频信号源相关的电路。 

    （3）当输入选项为 RUN 时，此时 KC901 根据用户设置进行输出。 

    （4）在信号源输出时，如果下发其它没有明确要求终止信号源输出的

命令，信号源继续输出。 

3.3.6 控制音频信号源输出 

命令 选项 参数 1 参数 2 参数 3 参数 4 参数 5 参数 6 

afsource 

init off 

ask 

fm 

pm 

afout 

** ** ** ** run port1 

stop port2 

说明： 

1、选项： 

    init->初始化 AfSource（在使用 AfSource 前必须使用此命令） 

    run->运行 AfSource 功能进行音频输出 

    stop->停止并关闭 AfSource 功能(在使用其他工作模式前必须使用此

命令) 

2、参数 1： 

    off->关闭调制功能，此时参数 4和参数 5不需要输入 

    ask->ASK 调制 

    fm->FM 调制 

pm->PM 调制 

3、参数 2： 

afout->选择输出口为音频输出(AF OUT) 
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port1->选择输出口为端口 1输出(PORT 1) 

port2->选择输出口为端口 2输出(PORT 2) 

3、参数 3： 

    载波频率，单位 Hz，取值范围：0-2000000000Hz 

4、参数 4： 

当输出端口为“afout”时，单位 mV(VPP)，取值范围：0-3000mV 

   当输出端口为“port1”或 pot2 时，代表载波输出幅度 单位 dBm,精度 

1dB  

   端口的输出幅度根据频率不同而不同。 

   当用户输入幅度高于实际可以输出的最大值时，下位机返回警告，并且

以最大值输出。 

$start,warn_gtr\n    ;用户输入大于最大值 

$warn:It is greater than the maximum output!\n 

$end\n 

   当用户输入幅度低于实际可以输出的最大值时，下位机返回警告，并且

以最小值输出。 

$start,warn_lt\n    ;用户输入大于最大值 

$warn:It is less than the minimum output!\n 

$end\n 

当输出端口为“port2”时，大致取值范围：+10 至-81dBm 

当输出端口为“port1”，且射频板版本不低于“1.0.5”时，取值范围：

+10 至-111dBm，否则取值范围依然为：+10 至-81dBm 

5、参数 5： 
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调制频率，单位 Hz. 

在 ASK 下，取值范围：0-3000Hz 

在 FM 以及 PM 下，取值范围：16-10000Hz 

6、参数 6： 

    调制深度/调制频偏 

    在 ASK 下，调制深度范围为 0-100% 

    在 FM 下，调制频偏为 0-1MHz 

    在 PM 下，调制相偏移为-180°-+180° 

7、例程： 

    控制音频信号源输出，要求ASK调制，载波频率10MHz，输出 1.3V(VPP)，

调制频率 1KHz，调制深度 100%。 

    第一步 初始化 AfSource 功能： 

    $afsource,init\n 

第二步 开始运行并设置： 

$afsource,run,ask,afout,10000000,1300,1000,100\n 

    第三步 如需使用其它功能，应先退出本模式。 

    $afsource,stop\n 

8、处理： 

    （1）当输入选项为 Init 时，KC901 会立即初始化与音频信号源相关的

电路。 

    （2）当输入选项为 STOP 时，KC901 会立即关闭音频信号源相关的电路。 

    （3）当输入选项为 RUN 时，KC901 根据用户设置进行输出。 

    （4）在信号源输出时，如果下达其它没有明确要求终止信号源输出的
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命令，信号源继续输出。 

3.4 上行指令 

    系统主动返回的指令一般是用于警告及提示，每一个警告就是一个包。

上位机编程时，通过包头即可判断错误类型，不需要匹配包内容。说明如

下： 

3.4.1 当指令发送错误时返回字符串 

$start,err_cmd\n      

$error:Command input error!\n 

$end\n 

3.4.2 当选项发送错误时返回字符串 

$start,err_opt\n        

$error:Option input error!\n 

$end\n 

3.4.3 当参数 X发送错误时返回此字符串 

$start,err_parx\n    ;参数 x输入错误，此处 x是变量，取值范围是 1-6 

$error:Parameterx input error!\n 

$end\n 

3.4.4 在使用某个模式先必须先初始化该模式 

$start,err_uninit\n      

$error:Please initialize the mode first!\n 

$end\n 

3.4.5 发射机失锁（需主动读取，见 3.2.23） 

$start,err_RfUnlock\n    
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$error:RF PLL unLock!\n 

$end\n 

3.4.6 接收机本振失锁（需主动读取，见 3.2.23） 

$start,err_LoUnlock\n    

$error:Lo PLL unLock!\n 

$end\n 

3.4.7 在使用某模式时，必须先停止其他正在运行的模式。 

$start,err_S11Stop\n    ;使用其他扫描模式前需要先停止 S11 模式 

$error:Please stop S11 mode first!\n 

$end\n 

  

$start,err_S21Stop\n    ;使用其他扫描模式前需要先停止 S21 模式 

$error:Please stop S21 mode first!\n 

$end\n 

  

$start,err_SpecStop\n   ;使用其他扫描模式前需要先停止 SPEC 模式 

$error:Please stop Spec mode first!\n 

$end\n 

  

$start,err_FieldStop\n   ;使用其他扫描模式前需要先停止 FIELD 模式 

$error:Please stop Field mode first!\n 

$end\n 
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$start,err_RfStop\n     ;使用其他扫描模式前需要先停止 RFSource 模

式 

$error:Please stop RFSource mode first!\n 

$end\n 

  

$start,err_AfStop\n     ;使用其他扫描模式前需要先停止 AFSource 模

式                   

$error:Please stop AFSource mode first!\n 

$end\n 

3.4.8 电池电压低（需主动读取，见 3.2.23） 

$start,err_BatVolLow\n   

$error:Low battery!\n 

$end\n 

3.4.9 外接电压高（需主动读取，见 3.2.23） 

$start,err_ExVolHigh\n   

$error:External Voltage is too high!\n 

$end\n 

3.4.10 温度高（需主动读取，见 3.2.23） 

$start,err_TempHigh\n    

$error:Temperature is too high!\n 

$end\n 
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3.5、版本说明 

 本手册适用于版本在 V1.5.6(KC901V/M) 1.2.9(KC901C+/S+) 1.2.1(KC901Q)及以

上的固件。低于该版本的固件，请参阅旧版手册。 

 

[结束] 


